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What is Asset and intellectual property shifting?
• Multinational enterprises (MNEs) may shift assets and intellectual property (IP) from one country to another for 

various reasons, including tax planning, regulatory requirements, and market access
• It's worth noting that not all asset and IP shifting by MNEs is illegal or improper. Many MNEs engage in legitimate 

tax planning activities that are within the bounds of the law. However, some MNEs may engage in abusive tax 
practices that are designed to evade taxes or take advantage of loopholes in the law. 

• It's important for countries to monitor the financial activities of MNEs to ensure that they are paying their fair share 
of taxes and not engaging in abusive practices.

• Here are some common methods that MNEs may use to shift assets and intellectual property:

1. Transfer pricing: MNEs may manipulate the prices at which they transfer goods or services between related 
companies in different countries to shift profits from high-tax to low-tax jurisdictions.

2. Debt financing: MNEs may use debt financing to shift profits to low-tax jurisdictions by paying interest on loans 
to related companies in those jurisdictions.

3. Royalty payments: MNEs may shift profits to low-tax jurisdictions by paying royalties on IP to related companies 
in those jurisdictions.

4. Licensing: MNEs may transfer IP ownership to subsidiaries in low-tax jurisdictions and then license the IP back to 
subsidiaries in higher-tax jurisdictions to shift profits.

5. Intangible asset transfers: MNEs may transfer ownership of intangible assets, such as patents or trademarks, to 
subsidiaries in low-tax jurisdictions to shift profits.



What Methods Do MNEs Use?

• Here are some common methods that MNEs may use to shift assets and intellectual 
property:

1. Transfer pricing: MNEs may manipulate the prices at which they transfer goods or 
services between related companies in different countries to shift profits from high-tax to 
low-tax jurisdictions.

2. Debt financing: MNEs may use debt financing to shift profits to low-tax jurisdictions by 
paying interest on loans to related companies in those jurisdictions.

3. Royalty payments: MNEs may shift profits to low-tax jurisdictions by paying royalties 
on IP to related companies in those jurisdictions.

4. Licensing: MNEs may transfer IP ownership to subsidiaries in low-tax jurisdictions and 
then license the IP back to subsidiaries in higher-tax jurisdictions to shift profits.

5. Intangible asset transfers: MNEs may transfer ownership of intangible assets, such as 
patents or trademarks, to subsidiaries in low-tax jurisdictions to shift profits.



How Do We Measure and Monitor MNEs in this area?

• Measuring and monitoring asset and intellectual property shifting by multinational enterprises 
(MNEs) can be a complex and challenging task. 

• There are several factors that can impact the accuracy of these measurements, including changes in 
company structure, variations in accounting methods, and differences in legal systems.

• There are some general methods and techniques that can be used to measure and monitor asset 
and intellectual property shifting by MNEs. 

• One common approach is to analyze the financial statements of MNEs, such as their balance sheets 
and income statements, to identify any changes in the value of their assets and intellectual property



Steps for measuring and monitoring MNEs in this areas
1. Gather financial data: Collect the financial statements of the MNEs you are interested in analyzing. 

You may be able to find this data on the company's website or through financial databases such as 
Bloomberg or Reuters.

2. Import the data: Use Pandas to import the financial data into your Python environment. This will 
allow you to manipulate the data and perform calculations.

3. Calculate changes in asset values: Use NumPy to calculate changes in the value of the MNE's 
assets over time. You may want to consider using percentage changes to account for differences in 
the size of the MNE.

4. Identify shifts in intellectual property: Analyze the MNE's financial statements to identify any 
changes in the value of their intellectual property. This could include patents, trademarks, and 
copyrights.

5. Visualize your findings: Use Matplotlib or Seaborn to create visualizations of your findings. This 
could include line charts showing changes in asset values over time or bar charts showing changes 
in the value of different types of intellectual property.

6. Interpret your findings: Finally, analyze your findings to identify any patterns or trends. This may 
require further research and analysis to determine the reasons behind any shifts in asset or 
intellectual property values.



What Model can we Use to monitor MNEs in this area?

1. Gather data: Collect financial data on MNEs operating in the country. This could include data on 
their assets, intellectual property, and revenue.

2. Preprocess the data: Use Python libraries such as Pandas and NumPy to preprocess the data. This 
may include cleaning the data, transforming variables, and creating new features.

3. Build the model: Choose a machine learning algorithm to build your model. You may want to 
consider using a classification algorithm such as logistic regression or random forest, which can 
predict whether an MNE is likely to engage in asset or intellectual property shifting.

4. Train the model: Split your data into training and testing sets and use the training set to fit your 
model.

5. Evaluate the model: Use the testing set to evaluate the performance of your model. You may want 
to consider using metrics such as accuracy, precision, and recall to measure the model's 
performance.

• Deploy the model: Once you are satisfied with the performance of your model, deploy it to monitor 
the financial activities of MNEs operating in the country. You may want to consider integrating the 
model into a larger system that can automatically flag any suspicious activity for further 
investigation
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WHAT ARE BASE EROSION AND PROFIT-
SHIFTING-BEPS?
• base erosion and profit shifting’ (BEPS) refers to ‘tax avoidance 'by 

multinational enterprises (MNEs) that use gaps in the interaction between 
different tax systems to reduce taxable income artificially, or shift profits to 
low-tax jurisdictions in which little or no economic activity is performed.

• The (OECD) issued a report in 2013 in which it noted that: ‘BEPS 
constitutes a serious risk to tax revenues, tax sovereignty and tax fairness 
for OECD member countries and non-members alike.

• This prompted it to come up with a ‘Fifteen Point BEPS Action Plan’ which 
is intended to ensure that profits are taxed where the economic activities 
generating those profits are performed and where value is created.



FREEDOMS OF TAX PAYERS AND POOR NATIONS

• To curtail tax avoidance, the practice in question has to be prevented 
through anti-tax avoidance provisions in domestic tax laws, double tax 
treaties, and through countries adhering to international initiatives and 
recommendations against tax avoidance, such as those in the OECD 
15 Point BEPS Action Plan (BEPS Action Plan 15).

• The term ‘tax avoidance’ must be distinguished from the term ‘tax 
evasion', which is illegal and entails the non-compliance with the tax 
laws and includes activities (like the falsification of tax returns and 
books of account) that are deliberately undertaken by a taxpayer to 
free itself illegally from the tax which the law charges upon its 
income.



TAX AVOIDANCE THE LAW AND MORALITY

• Historically, the courts have held that there is no morality when it comes to paying 
taxes. This was confirmed by Lord President Clyde in the UK case of Ayrshire 
Pullman Motors Services and D M Ritchie v IRC 11

• [n]o man in this country is under the smallest obligation, moral or otherwise, to arrange his 
legal relations to his business or to his property so as to enable the Inland Revenue to put the 
largest possible shovel into his stores. The Inland Revenue is not slow – and quite rightly – to 
take advantage, which is open to it under the taxing Statutes for the purpose of depleting the 
taxpayer’s pocket. The taxpayer is in the like manner, entitled to be astute to prevent, so far as 
he honestly can, the depletion of his means by the Revenue.

• Lord Tomlin also held in the celebrated case of Duke of Westminster as Follows:
• [e]very man is entitled if he can to order his affairs so that the tax attaching under the 

appropriate Act is less than it otherwise would be. If he succeeds in ordering them so as to 
secure this result, then, however inappropriate to the Commissioner of Inland Revenue or his 
fellow taxpayers may be of his ingenuity, he cannot be compelled to pay an increased tax.



CURRENT STATE OF OPINION ON TAX AVOIDANCE

• Even though tax avoidance is not illegal, over the years it is has been frowned 
upon by the courts and by tax authorities as the resultant loss of tax revenue has 
the effect of limiting a government’s ability to pursue its economic and social 
objectives. 

• Indeed, the morality of tax avoidance was questioned years back in Re Weston’s 
Settlements, where Lord Denning made a characteristically terse admonition that 
‘the avoidance of tax may be lawful, but it is not yet a virtue’.

• In CIR v McGuckian,16 Lord Steyn remarked that the Duke of Westminster 
notion that a taxpayer is free to arrange its financial affairs as it thinks fit, had 
‘ceased to be canonical’ as to the consequences of a tax avoidance scheme. 

• And in the New Zealand case of Elmiger v CIR, it was held that the ingenious 
legal devices contrived to enable individual taxpayers to minimise or avoid their 
tax liabilities are often not merely sterile or unproductive in themselves (except 
perhaps in respect of their tax advantages for the taxpayer concerned), but that 
they have social consequences which are contrary to the general public interest.



PREVIOUS ATTEMPTS TO CURTAIL BEPS

• In an attempt to lessen their global tax exposure, MNEs have increasingly
used global tax avoidance strategies to maximise profits while their links to 
any country with a favourable tax climate have become more tenuous. 
• In response, countries have enacted various anti-avoidance measures to 

curtail these tax avoidance strategies – taxpayers, however, are usually one 
step ahead. 

• The cycle of continuous amendment to close loopholes in tax legislation has 
complicated most countries’ corporate income tax provisions without, 
however, preventing well-advised taxpayers from aggressively avoiding 
domestic taxes by keeping their income in low-tax jurisdictions.



CONDUCT OF INDUSTRAIL NATIONS

• For many years the OECD and EU failed to acknowledge that their 
companies were giving both they and developing countries a raw deal, 
especialy in supporting or closing eyes to tax heavens

• As the growth of tax havens continued to be a major cause of the depletion 
of countries’ tax bases, from the early 1990s the international community 
began to take measures to stifle their development.

• The European Union (EU) issued a report containing recommendations on 
company taxation in Europe that would prevent residents of member 
countries from transferring investments to other member countries that 
levied lower taxes. 

• Since then the EU has issued various directives to prevent the depletion of 
its members’ tax bases



CSOS AND THE TAX JUSTICE CAMPAIGN
• In the aftermath of the 2007/8 global financial crisis, concerns about MNE not 

paying their fair share of taxes again took centre stage, engineered by non-
governmental organisations like Christian Aid40 and the Tax Justice Network,41 
which voiced public concerns about companies paying little or no corporation tax 
in the countries in which they conduct business.

• At the 2012 G20 summit in Mexico, the national leaders explicitly referred to the 
need to prevent BEPS and, at the behest of the G20, in February 2013 the OECD 
released its BEPS Report

• BEPS is enabled by the fact that the current international corporate taxation 
framework has not kept pace with the changing business environment. 

• Domestic rules for international taxation and internationally agreed standards 
remain grounded in an economic environment characterised by a lower degree of 
economic integration across borders, rather than today’s environment of global 
taxpayers, which is characterised by MNE companies that are increasingly placing 
importance on intellectual property as a value-driver and the development of 
information and communication technologies.



IMPORTANCE OF CORPORATE TAX IN AFRICA

• Corporate tax system is a very important source of revenue in African 
countries and must be retained. 

• While in OECD countries corporate tax does not represent an important 
source of revenue, this is not true of developing countries where it generally 
contributes more than 25 per cent of total revenue. In Africa, the continental 
average is 29 per cent of total revenue.

• Unlike in developed countries which derive reasonable amounts of revenue 
from individual income and consumption taxes, in many developing 
countries domestic economic activity is informal through businesses which 
maintain few if any bookkeeping and financial records. 

• As a result, developing country governments’ ability to raise revenue from 
individual and consumption taxes is limited.



BEPS AND CAPITAL FLIGHT IN AFRICA
• The problem of capital flight in Africa falls under two main categories: 

legitimate capital flight and illicit capital flight.
• Global Financial Integrity’ notes that ‘Illicit financial flows are by far the 

most damaging economic problem facing Africa’ and are considered the 
‘most pernicious global development challenge of our time’

• There is no universally agreed definition of illicit financial flows and its 
boundaries are disputed. The term generally implies the movement of 
money in a way that contravenes the laws or regulations of a country. These 
money movements can be the result of illegal activities like tax evasion, 
organised crime, customs fraud, money laundering, terrorist financing, and 
bribery. 

• However, some controversial definitions include in illicit financial flows 
certain corporate tax avoiding practices, such as BEPS despite their being 
legal



BEPS IN AFRICA
• African countries have been victims of this practice for decades, with their 

residents shifting money to developed countries and tax haven jurisdictions. 
• The loss of tax revenue resulting from BEPS leads to critical under-funding 

of public investment that could help promote economic growth. 
• It also impacts negatively on badly needed finances to fund public 

infrastructure such as roads, hospitals, and schools. BEPS undermines the 
integrity of the tax system. 

• It discourages tax morality and encourages a perception that the tax system 
is unfair. 

• This, in turn, undermines voluntary compliance by all taxpayers. It also 
undermines competition as MNEs enjoy a competitive edge over enterprises 
that operate at domestic level, especially small and medium-sized 
enterprises.



THE RELEVANCE OF THE OECD BEPS PROJECT 
TO AFRICA
• The OECD 2013 BEPS Action Plan notes that in order to ensure 

international consensus in addressing BEPS, it would take into account the 
perspectives of developing countries.  

• However, criticism has been raised that the OECD agenda is driven by the 
interests of developed countries and that the interests of developing 
countries are not being addressed as they were not consulted as to tabling 
their concerns before the OECD 15 Point Action agenda was drafted and 
closed. 

• The OECD’s initial regional consultations only served as orientations to a 
pre-existing plan which fell short of global equal participation in the 
formulation of the international tax reforms. 

• Its BEPS Action agenda is criticised for embodying rules set by a few 
countries so reinforcing a system that exacerbates global inequality



OTHER CONCERNS OF AFRICAN COUNTRIES

• The OECD’s approach has also been criticised for not addressing fundamental international tax 
reforms or re-examining the basic principles of the international tax system which are pivotal in 
addressing BEPS, such as the allocation of tax income between residence and source countries.

• OECD chose to focus on curtailing tax avoidance schemes by strengthening existing anti-
avoidance provisions, to ensure that they would be more effective in curtailing BEPS under 
modern business models. 

• However, since taxpayers have manipulated these anti-avoidance provisions to a point at which 
they have become ineffective, there is little reason to expect that strengthening the rules further will 
prevent BEPS.

• It has therefore been suggested that the OECD’s BEPS Action agenda is a reactionary approach to 
meet revenue demands by European countries to cover their budgetary deficits after the 2007/2008 
global financial crisis which left many of them in a position of capital importers and which are now 
disadvantaged by the international tax rules that were crafted to suit them. 

• Now that damaging effects have been felt by rich countries, they have developed the political will 
to the find solutions to the problems that developing countries have been struggling with for 
decades.



HOW SHOULD AFRICA RESPOND BE TO THE OECD 
BEPS ACTION PLAN?
• No African country is a member of the OECD, and African countries are not
• bound to follow OECD recommendations. Although the primary focus of the OECD is on 

its member countries, its additional goals of contributing to the expansion of world trade 
and the development of the world economy, also affect non-members.

• It would, therefore, be in the interest of African countries to respond to the OECD 
recommendations since BEPS is a global challenge that requires a global solution. 

• All countries (including African economies) have a shared interest in strengthening the 
integrity of the international corporate tax system. 

• Given that many African countries have large resource bases that are exploited by foreign 
investors, it is important that they take proactive steps to prevent BEPS.

• There has been a shift in the philosophies of some governments that encouraged the 
perpetuation of certain notorious tax avoidance schemes. 

• For example, the Irish government has taken measures to close tax loopholes that permit 
the use of the ‘double Irish sandwich’ scheme which allowed companies registered in 
Ireland to be stateless and thus pay tax nowhere.



EXERCISES-MEASURING IFFS USING PARTNER COUNTRY-PCM AND 
PRICE FILTER-PFM METHODS 
 
PCM 
STEPS 

1. Use the Tax Jus�ce Network pla�orm on country vulnerability, intensity and exposure 
to IFFs to analyse for commodi�es and countries of des�na�on cons�tu�ng the 
highest IFFs risks to your country 

2. Select one commodity to measure for a year 
3. Iden�fy country of des�na�on 
4. Retrieve export data from expor�ng country 
5. Retrieve import data from impor�ng country 
6. Compare their values 
7. Adjust for transport 
8. Adjust for insurance 
9. Adjust for mark-up 
10. Establish the threshold where you will say the difference is abnormal and thus IFF 
11. Summary grand totals of inflows and ou�lows. 

 
Excel Implementa�on of PCM: 
Modeling PCM for Ghana 
I. Objec�ves:  
a. Es�mate the difference between country A ’s reported export to its partner countries 
(Ghana_X.xlsx) and Partner countries’ reported import from country A (Partner_M.xlsx) 
b. Es�mate the difference between country A’s reported import from its partner 
countries (Ghana_M.xlsx) and Partner countries’ reported export to country A 
(Partner_X.xlsx) 
c. Iden�fy top 10 or 20 high-risk countries with misinvoicing in export and import 
 
II. Data source: IMF DOTS, 2012 monthly. 
 
Modeling steps: 
 

I.Complica�on:  
The list of partner countries reported by Ghana does not match the partner countries 
which reported having trade (export or import) with Ghana. 
Illustra�on:  



II.Ghana’s export list of partner countries: A, B, C, D 
III.List of Countries reported as having imported from Ghana: A, B, D, E. 
IV.For Country C, Ghana reported as having exported but Country C did not report any 

import from Ghana 
V.For Country E, Ghana has no record of having exported to E, but E reported as having 

imported from Ghana 
VI.To put together all the data from Ghana’s export and Partners’ import, we need to 

create a list of all countries: A, B, C, D, and E: Name the file as 
PCM_Ghana_X_Analysis.xlsx (PCM_Ghana_M_Analysis.xlsx for import analysis.) This 
file has only one column with a list of all the countries, A, B, C, D, E. 

VII.Using Power Pivot in Excel, build a model rela�ng PCM_Ghana_X_Analysis.xlsx to 
Ghana_X_2012.xlsx and Partner_M_2012.xlsx and create calculated fields: 

i. Export_Over_Invoiced_amount =  MAX(0, (Ghana_X – 
Partner_M/1.1)) 

ii. Export_Under_Invoiced_amount = MAX(0,(Partner_M/1.1 – 
Ghana_X)) 

iii. Dividing import data by a factor of 1.1 is because import data is 
reported as CIF while export data as FOB. 

 

VIII.Modeling PCM using Power Pivot for Ghana Export misinvoicing 
IX.Open a new Excel blank workbook. Save it as =xlsx  

(If Power Pivot is not ac�vated, ac�vate Power Pivot:  File > Op�ons > Add-ins > 
Select “Microso� Power Pivot for Excel” from Inac�ve Applica�on Add-ins list) 

X.Click “Power Pivot” from the ribbon 

XI.Click Manage 

 



XII.To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External 
Data” group 

XIII.You will see a list of Rela�onal Databases. Scroll through to the botom of the list. 
Select Excel File (or Text File for impor�ng a CSV file) > Browse > & check “Use first row 
as column headers” > Next > Finish (name the table as Ghana_X) 

XIV.Repeat to import Partner_M_2012.xlsx (name the table as Partner_M) and 
PCM_Ghana_X_Analysis.xlsx (name the table as Ghana_X_IFF) 

XV.Click “Diagram View”  in View Group 

XVI.Then you will see three tables 

 
 

XVII.At this point, three tables are not related to each other. To model the rela�on between 
Ghana_X_IFF and Ghana_X, drag the field, “Partner” from Ghana_X_IFF to “Partner” 
in Ghana_X. Repeat this process for Partner in Ghana_X_IFF to Reporter in Partner_M . 

XVIII.There should be lines linking tables. At the ends of the lines, a “*” should be on the 
side of Ghana_X_IFF table and a “1” on Ghana_X and Partner_M. This indicates one-
to-many rela�ons. 
 



XIX.Now click “Data View” in the View group: 

 
 

 
You should see a list of three tables at 
the botom: Ghana_X, Partner_M, 
Ghana_X_IFF. Above Ghana_X_IFF, 
only one table heading (field name) is 
shown: Partner.  
Inser�ng Calculated Fields 
Double click the heading “Add 
Column” on the top right-hand side, 
and you can name a new field name 
to be calculated. Name it as Ghana_X. 
Add three more columns: Partner_X, 
Ghana_X_Over, Ghana_X_Under. 
No�ce the calculated fields are 
highlighted in black. 
 
Now put a formula for each calculated 
field: 
Start with Ghana_X: 
- Click the heading 
- Type “=” and con�nue type 
“related(" > select the field 
“Ghana_X[G_X_2012] > type with a 
closing parenthesis “)”. No�ce the 
column will be populated with the 

export data from Ghana_X table. 
- Repeat the same procedure for Partner_M field, 

“=Related(Partner_M[_P_M_2012])” 
 
 



- Now put a formula for Ghana_X_Over as:  
 “=max(0,Ghana_X_IFF[Ghana_X]-Ghana_X_IFF[Partner_M]/1.1)” 

 

For easy reading, the numbers may be formated as $ with no decimals.  
This completes the Ghana’s Export overinvoicing and Export under-invoicing calcula�on. 
 

XX.Create Pivot Table to sort by IFF amount and iden�fy high-risk 
partners 

 
 

XXII.Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un 
 



 
 

XXIII.Select the en�re pivot table and copy it. 
XXIV.Paste it in a range somewhere below the pivot table: Click Home > Paste (down arrow) 

> Select “Values (V)”  from “Paste Values” group 
XXV.To find the list of top 10 (or 20) high risk countries with Export Underinvoicing, sort 

the table in descending order of Ghana_X_un.  
 

XXVI.To find the list of top 10 (or 20) high risk countries with Export Overinvoicing, sort the 
table in descending order of Ghana_X_ov.  
 

XXVII.Modeling PCM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import analysis, follow the same process as in “IV. 
Modeling PCM using Power Pivot for Ghana Export misinvoicing” 
and “V. Create Pivot Table to sort by IFF amount and iden�fy high-
risk partners.” 

Price Filter Method-PFM 
1. Use Tax Jus�ce Network pla�orm and analyse for the commodi�es and countries of 

des�na�ons with the highest risks of mispricing 
2. Iden�fy one commodity you want to analyse for a year 
3. Consolidate the commodity values for one year 



4. Determine whether the commodity has established market price or not. 
5. If commodity has established market price, then use market prices to compare with 

declared values by trader 
6. Treat the established market price as the Arm’s Length price 
7. Determine the threshold values below and above this arm’s length price 
8. Consolidate the under-invoiced amounts for a year 
9. Consolidate the over-invoiced amounts for a year 
10. If there is no established market price for the commodity, then use a sta�s�cal 

method to es�mate an arm’s length price 
11. Treat this as the arm’s length price 
12. Compare this arm’s length price to the declared values 
13. Determine which values are above(under-invoicing) and which are below (over-

invoicing) the arm’s length price 
14. Consolidate under-invoiced amount for a year 
15. Consolidate the over-invoiced amount for a year 
16. Iden�fy individual businesses with the highest risks 
17. Iden�fy the countries of des�na�on for commodi�es with highest risks(top 10 to 20) 
18. Iden�fy commodi�es with the highest risks(top 10 to 20) 

 
Excel Implementa�on of PFM 
Modeling PFM US Export to Country A (Ghana, Liberia, Nigeria or Sierra Leone) 
I. Objectives:  
a. Estimate the overinvoiced amount (amt_ov_w) and the underinvoiced amount 
(amt_un_w) in the U.S. export data using a US-World Price filters (upper quartile price 
“PUpQ” and lower quartile price “PUpQ”). Amt_ov_w = MAX(0, (price – 
PUpQ)*Quantity) Amt_un_w= MAX(0,(PLoQ – price)*Quantity) 
b. Identify top 10 or 20 high-risk commodity groups (by HS10 and HS02) 
II. Data source: US Merchandise Trade: Exports – Monthly (2012) Web: 
https://www.census.gov/foreign-trade/statistics/dataproducts/index.html 
 

XXVIII.Complica�on:  
The US Export data (US_Exp_toGhana2012.xlsx) include several fields: HS10 code 
(commodity), country code (cty_code), quan�ty (all_qy1_mo), and value (all_val_mo). 
The commodity names are on a separate reference table (hs10x12.xlsx). HS02 code can 
be extracted from HS10, but it also needs a reference table for HS02 (HS02.xlsx). The 
price filters are on its own table (MTX1212X_Wrld.xlsx based on US-World trade records 
and MTX1212X_Ghana.xlsx based on US-Ghana trade records.) 
 
It is necessary to model rela�ng the US Export data (US_Exp_toGhana2012.xlsx) table to 
four other tables. This requires using a rela�onal database tool. The Power Pivot in Excel 
is used in this exercise.  Other tools such as Microso� SQL Server, Oracle Database, 
MySQL, IBM DB2, and PostgreSQL are more efficient but has significant steep learning 
curve compared to Excel Power Pivot. 

https://www.census.gov/foreign-trade/statistics/dataproducts/index.html


 

XXIX.Modeling PFM using Power Pivot for Ghana Export misinvoicing 
XXX.Open a new Excel blank workbook. Save it as PFM_US_X_to_Ghana.xlsx  

(If Power Pivot is not ac�vated, ac�vate Power Pivot:  File > Op�ons > Add-ins > 
Select “Microso� Power Pivot for Excel” from Inac�ve Applica�on Add-ins list) 

XXXI.Click “Power Pivot” from the ribbon 

XXXII.Click Manage 

 



XXXIII.To import US_Exp_toGhana2012.xlsx data, select “From Other Sources” from “Get 
External Data” group 

XXXIV.You will see a list of Rela�onal Databases. Scroll through to the botom of the list. 
Select Excel File (or Text File for impor�ng a CSV file) > Browse > & check “Use first row 
as column headers” > Next > Finish (name the table as Exp12toGhana) 

XXXV.Repeat to import MTX1212X_Wrld.xlsx (name the table as MTX1212X_Wrld), 
MTX1212X_Ghana.xlsx (name the table as MTX1212X_Ghan), hs10x12.xlsx (name the 
table as hs10x12), and hs02.xlsx (name the table as hs02) 

XXXVI.Click “Diagram View”  in View Group 

XXXVII.Then you will see five tables.  Link fields from tables to model/create the rela�ons as 
follows: 
 

Commodity in Exp12toGhana  
 commodity in hs10x02 

1.  hs10 in MTX1212X_Wrld  
2. hs10 in MTX1212X_Ghana 
 HS2 in Exp12toGhana  commodity in hs02 



Here is the diagram view of the completed model: 

 
 

XXXVIII.Now click “Data View” in the View group: 

 
 

 
You should see a list of five tables at the botom: Exp12toGhana, 
MTX1212X_Wrld, MTX1212X_Ghana, hs10x12, hs02. 

 
XXXIX.Inser�ng Calculated Fields 

Go to the table, “Exp12toGhana” 
Double click the heading “Add Column” on the top right-hand side, and you can 
name a new field name to be calculated. Name it as price. Add six more 
columns: PLoQ_W, PUpQ_W, amt_un_w, amt_ov_w, descript_2, 
HS2_Descrip�on. No�ce the calculated fields are highlighted in black. 

 
Now put a formula for each calculated field: 
Start with price: 

- Click the heading 
- Type “=” and con�nue type  

“=if(Exp12toGhana[all_qy1_mo]>0,Exp12toGhana[all_val_mo]/Exp12toGhana[all_qy1_mo],0
)” 
 

- Repeat the same procedure for the remaining fields: 



- PLoQ_W: “=IF(ISBLANK(RELATED(MTX1212X_Wrld[ploq])), 
0,RELATED(MTX1212X_Wrld[ploq])) 

- PUpQ_W: “=IF(ISBLANK(RELATED(MTX1212X_Wrld[pupq])),0, 
RELATED(MTX1212X_Wrld[pupq]))” 

- amt_un_w: “=max(0,(Exp12toGhana[PLoQ_W] - Exp12toGhana[price])* 
Exp12toGhana[all_qy1_mo])” 

- amt_ov_w: “=max(0,(Exp12toGhana[price]-Exp12toGhana[PUpQ_W])* 
Exp12toGhana[all_qy1_mo])”  

- descript_2: “=RELATED(hs10x12[descrip_2])”  (comment: This is HS10 descrip�on) 
- HS2_Descrip�on: “=RELATED(hs02[abbreviatn])” 
 
For easy reading, the numbers may be formated as $ with two decimals for price fields, 
no decimals for amount fields.  

 
 
 

XL.Create Pivot Table to sort by IFF amount and iden�fy high-risk HS10 
commodity groups 

XLI.PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet” 

 
 



 
XLII. Select the field “Descrip_2” from 

Exp12toGhana table 
- Then select three more fields from the 
same table: all_val_mo, amt_un_w, amt_ov_w 

XLIII. Select the en�re pivot table and copy 
it. 

XLIV. Paste it in a range somewhere below 
the pivot table: Click Home > Paste (down 
arrow) > Select “Values (V)” from “Paste 
Values” group 

XLV. To find the list of top 10 (or 20) high 
risk commodi�es (at HS10 level) with 
Export Underinvoicing, sort the table in 
descending order of amt_un_w.  

XLVI. To find the list of top 10 (or 20) high 
risk commodi�es (at HS10 level) with 
Export Overinvoicing, sort the table in 
descending order of amt_ov_w.  
 

This completes the PFM model for Ghana Export mispricing based on the US-World Price 
filter. 
 
By using MTX1212X_Ghana, you can create a PFM model for Ghana Export mispricing based 
on the US-Ghana Price filter. 
 

XLVII.Modeling PFM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import PFM analysis, follow the same process as in 
above steps “IV” and “V.” 

      Files for tables: 
- US_Imp_fromGhana2012.xlsx 
- MTX1212M_Wrld.xlsx  (comment: Import commodity classifica�on is different from 

Export commodity classifica�on) 
- MTX1212M_GHANA.xlsx 
- hs10m12.xlsx 
- hs02.xlsx 

XLVIII.Final Note 
- The data files, US_Imp_fromGhana2012.xlsx and US_Exp_fromGhana2012.xlsx, are 

extracted US import from Ghana and US export to Ghana from US Import data file 
and US Export data file, respec�vely. 



- The price matrix files (MTX1212X_Wrld.xlsx, MTX1212X_Ghana.xlsx, 
MTX1212M_Wrld.xlsx, MTX1212M_Ghana.xlsx) are originally created using a 
rela�onal database program from export and import records.  

- In this exercise, there were substan�al amount of manual processing. However, the 
en�re exercise in session 10 can be automated using a rela�onal database program 
star�ng from raw data at transac�on level. The Power Pivot in Excel helps us 
understand the concept of rela�onal database model building and create calculated 
fields of interest. 
 

(Datasets prepared by Dr Simon Pak from USA and Ghana data(supplied by ISODEC) 



GSS/ISODEC TRAINING 
WORKSHOP ON MEASURING 

IFFS IN WEST AFRICA
MONTORING IFFS IN COMPANY OPERATIONS AND TAX RETURNS



WHAT TO MONITOR

• monitor payments of royalties, withholding taxes, management fees, loan interests, and other 
financial transactions related to your MNE 

• Establish a centralized system: Create a centralized system to manage all financial transactions related 
to your MNE. This system should be accessible to all stakeholders involved in financial transactions, 
including your MNE’s financial team, auditors, tax authorities, and other relevant parties.

• Use accounting software: Use accounting software to track all financial transactions related to your 
MNE. This software should be able to record, process, and report financial transactions, including 
payments of royalties, withholding taxes, management fees, loan interests, and other expenses.

• Implement controls: Implement controls to ensure that all financial transactions are recorded accurately 
and on time. This includes implementing internal controls to prevent fraud and errors in financial 
reporting.

• Hire experts: Hire experts in tax, accounting, and finance to oversee financial transactions related to 
your MNE. These experts can help ensure compliance with local tax laws and regulations and provide 
guidance on financial reporting.

• Monitor compliance: Monitor compliance with local tax laws and regulations to ensure that your MNE is 
paying the correct amount of taxes and royalties. This includes staying up-to-date on changes in tax laws 
and regulations and regularly reviewing financial statements.

• Conduct audits: Conduct regular audits of your MNE’s financial transactions to ensure that they are 
accurate and comply with local tax laws and regulations. This can help identify areas for improvement 
and prevent financial errors and fraud.



USING WHAT METRICS TO MONITOR?

• Gross margin: This metric represents the difference between your MNE's revenue and cost of 
goods sold. It can help you evaluate the profitability of your MNE's operations and identify areas 
for improvement.

• Return on investment (ROI): ROI measures the return on investment for a particular financial 
transaction. It can help you evaluate the effectiveness of your MNE's investments and identify areas 
where the return is not meeting expectations.

• Accounts receivable turnover: This metric represents the number of times your MNE collects its 
average accounts receivable balance during a given period. It can help you evaluate the efficiency 
of your MNE's collections process and identify areas for improvement.

• Inventory turnover: This metric represents the number of times your MNE sells and replaces its 
inventory during a given period. It can help you evaluate the efficiency of your MNE's inventory 
management and identify areas for improvement.

• Operating cash flow: Operating cash flow measures the cash generated or used by your MNE's 
operations. It can help you evaluate the ability of your MNE to generate cash from its core 
operations and identify areas where cash flow may be improving or declining.

• Debt-to-equity ratio: This metric measures the proportion of debt and equity financing that your 
MNE is using. A high debt-to-equity ratio indicates that your MNE may be taking on too much debt 
and may be at risk of defaulting on its loans



What Metrics to measure MNEs Continued

• Revenue growth: This metric measures the increase or decrease in your MNE's 
revenue over time. A steady or increasing revenue growth rate can indicate a 
healthy financial position, while a declining rate can signal issues that need to be 
addressed.

• Profitability: This metric measures your MNE's ability to generate profits from its 
operations. It can be measured in terms of gross profit margin, operating profit 
margin, or net profit margin. A healthy profit margin indicates that your MNE is 
efficiently managing its costs and generating revenue.

• Cash flow: This metric measures the amount of cash that your MNE generates or 
uses in its operations. Positive cash flow indicates that your MNE has enough cash 
to cover its expenses, invest in growth opportunities, and pay dividends to 
shareholders.

• Compliance with tax laws and regulations: This metric measures your MNE's 
compliance with local tax laws and regulations. It can be measured in terms of the 
accuracy and completeness of your MNE's tax filings, as well as its ability to pay 
taxes on time.  A delay in paying taxes means borrowing from the state at zero 
interest,meanwhile if and when the MNE lends to money they charge interests



YOU NEED A MODEL THAT EMPOWERS YOU TO:
1. Connect to your financial data sources: Depending on the sources of your financial data, you 

may need to connect to databases, APIs, or file systems. Python has many libraries that can be used 
to connect to different data sources, such as pandas, SQLAlchemy, and Pyodbc.

2. Extract and clean your financial data: Once you have connected to your data sources, you can 
use Python to extract and clean your financial data. For example, you can use pandas to read and 
clean data from Excel files or SQL databases.

3. Calculate financial metrics: After cleaning your financial data, you can use Python to calculate 
financial metrics such as revenue growth, profitability, and cash flow. You can write custom 
functions to calculate these metrics or use pre-built functions from libraries such as NumPy and 
SciPy.

4. Visualize your financial data: Python has several libraries for data visualization, such as Matplotlib 
and Seaborn. You can use these libraries to create charts and graphs to visualize your financial 
metrics and identify trends.

5. Set up automated reporting and alerting: You can use Python or R to automate financial 
reporting and alerting. For example, you can set up a script to generate daily or weekly reports on 
your financial metrics and send them to stakeholders via email or Slack. You can also set up alerts 
to notify you when certain metrics fall outside of acceptable ranges.



STEPS TO DESIGN AND OPERATIONALISE SUCH A MODEL
1. Define the scope and objectives of the model: You need to determine what aspects of BEPS you want to measure 

and monitor, what information you need to collect, and what the ultimate goal of the model is.

2. Identify relevant data sources: You need to identify the data sources that can provide the necessary information 
for the model. This may include tax and financial data, as well as other relevant economic and industry-specific 
data.

3. Develop an analytical framework: You need to develop a framework that outlines how the data will be analyzed 
and interpreted to measure and monitor BEPS. This framework may involve developing algorithms or models that 
can identify patterns of BEPS activity.

4. Create the model: Based on the framework, you can create the actual model. This may involve building a software 
application or spreadsheet that can analyze the data and provide outputs that measure and monitor BEPS.

5. Test and validate the model: You need to test and validate the model to ensure that it is accurate and reliable. 
This may involve using real-world data to see how the model performs and making adjustments as necessary.

6. Implement the model: Once the model has been tested and validated, it can be implemented. This may involve 
integrating the model into existing tax and financial reporting systems, or it may involve creating new reporting 
systems to support the model.

7. Monitor and update the model: You need to continually monitor and update the model to ensure that it remains 
accurate and relevant over time. This may involve updating the data sources or modifying the analytical framework 
as new BEPS risks and challenges emerge.



END, THANK YOU FOR LISTENING



GSS/ISODEC IFFs TRAINING FOR 
Ghana, Liberia, Nigeria and 
Sierra Leone-March-2023

Des ign in g a n d  u s in g loca l Com p a r a b le s in  Tr a d e  Mis -
p r icin g a n d  Tr a n s fe r -P r icin g

(Bish op  Akolgo)



THE CHALLENGE

• Combatting trade mis-pricing and transfer-pricing manipulations by 
multinational enterprises (MNEs) can be challenging for developing 
countries like Ghana

• However, one approach that can be used to address these issues is to 
construct and use local comparables.

• Local comparables are companies that are similar to the MNEs 
operating in Ghana, in terms of their size, industry, and operations.

• These local comparables can be used to benchmark the prices that 
the MNEs are charging for their goods or services. 

• This will help to identify any pricing discrepancies that may be the 
result of trade mis-pricing or transfer-pricing manipulations.



HOW TO DO THIS

• To construct local comparables, a country can use publicly available 
financial information from local companies operating in the same 
industry as the MNEs. 

• Ghana can also seek the assistance of international organizations such 
as the United Nations Conference on Trade and Development 
(UNCTAD) or the International Monetary Fund (IMF) to provide 
guidance on how to construct local comparables.

• Once local comparables are constructed, the country can use them to 
compare the prices charged by the MNEs with those charged by local 
companies. 

• This can help to identify any discrepancies and take appropriate 
action to address the issue.



OTHER MEASURES

• In addition to constructing local comparables, a country can also 
strengthen its transfer pricing regulations and increase its capacity to 
enforce these regulations. 

• This can include training tax officials to identify and investigate 
transfer pricing issues, as well as investing in technology and data 
analytics to assist in the detection of transfer pricing manipulations.

• Overall, constructing and using local comparables can be a useful tool 
for developing countries like ours to combat trade mis-pricing and 
transfer-pricing manipulations by MNEs. 

• However, this approach should be used in conjunction with other 
measures to strengthen transfer pricing regulations and build capacity 
for enforcement.



EXAMPLE IMPLEMENTATION USING PYTHON

1.DataTable: The DataTable interface allows you to display and interact with tabular 
data. You can use this interface to display the financial information of local 
companies and MNEs, and compare them side by side.

2.Graph: The Graph interface allows you to create and display different types of 
graphs and visualizations. You can use this interface to plot the prices charged by 
the MNEs and local comparables, and identify any discrepancies.

3.Dropdown: The Dropdown interface allows you to create a dropdown menu that 
users can use to select different options. You can use this interface to allow users 
to select the industry or sector they want to analyze, and display the 
corresponding data.

4.Slider: The Slider interface allows you to create a slider that users can use to 
select a range of values. You can use this interface to allow users to filter the data 
based on specific criteria, such as revenue or profit.

5.Input: The Input interface allows you to create a text input box that users can use 
to enter specific values. You can use this interface to allow users to search for 
specific companies or data points.



TO SUMMARISE
• Based on this user interface allows users to select the industry or sector 

they want to analyze, filter the data based on specific criteria such as 
revenue or profit, and search for specific companies or data points. 

• The DataTable displays the financial information of local companies and 
MNEs side by side, and the Graph plots the prices charged by the MNEs 
and local comparables, allowing users to compare them and identify any 
discrepancies in real-time. The app callbacks filter the data based on the 
user's inputs and update the DataTable and Graph accordingly, allowing for 
real-time monitoring of trade mis-pricing and transfer-pricing abuse.

You can add more interfaces such as a map interface to visualize the 
locations of the local comparables and MNEs, or a dropdown menu to select 
the type of transaction to analyze. 
The possibilities are endless, and you can use Plotly Dash to create a 
powerful and customizable user interface for real-time monitoring of trade 
mis-pricing and transfer-pricing abuse.



SAMPLE CODE



TOOLS FOR DATA 
EXPLORATION AND ANALYSIS

KEY PYTHON-BASED TOOLS
(By Bishop Akolgo)

(GSS/UNCTAD WORKSHOP ON THE MEASUREMENT OF IFFS)
ISODEC Offices-Accra-24th to 28th April, 2023



WHAT IS THE INTERQUARTILE AND WHY USE IT

• five-number summary is mostly used IN STATISTICS as it gives a rough 
idea about the dataset.

• 1.Minimum value: It is the minimum value in the data set.
• 2.First Quartile, Q1: It is also known as the lower quartile where 25% 

of the scores fall below it.
• 3.Median (middle value) or second quartile: It is basically the mid-

value in the dataset.
• 4.Third Quartile, Q3: It is also known as the Upper quartile in which 

25% of the data is above it and the rest 75% falls below it.
• 5.Maximum value: It is the maximum value in the dataset.



PRICE FILTER METHOD

• Arm’s length price filter: benchmark upper and lower bounds of 
prices for each commodity

• a. Market price filter: (market price) +/- 5%, 10%, or more
• b. Non-market price filter (Pak and Zdanowicz (1994): Statistical 

estimates
• Upper and lower prices in quintiles (eg: quartile, quintile, or decile) 
for each commodity code
• c. Requires detailed trade data at transaction level
• No need for partners’ trade statistics



Interquartile Range

• Mathematically, it is basically defined as the difference between the 
third quartile (75th  percentile) and the first quartile (25th percentile).

• Q3-Q1
• IQR denotes the middle 50% hence also known as midspread or H-

spread in statistics



THE EXERCISE



Interquartile range calculation

• Follow the below steps to calculate the same:
• Step 1: Insert the dataset.
• Step 2: Select any cell where you want to write the formula to 

calculate the values of Q1, Q3, and IQR.
• Step 3: First find the values of Q1 and Q3 using the quart values as 1 

and 3 respectively.
• Step 4: deduct Q1 from Q3
• Step 5: Lets practice



CREATING INTERQUARTILE RANGE

• PRICE=Value/Quantity
• Total 195 records
• Low Quartile at 195*0.25 = 49th (go to row 52)
• Median price at 195*0.5 = 98th   (go to row 102) 
• Upper quartile at 195*0.75 = 146th (go to row 149)

• Overpriced =(price - upper quartile price) or zero if negative
• Underpriced = (PRICE -lower quartile price) or zero if negative
• Lower Quartile Price=3.803468208
• Upper Quartile Price=6.020361991



SUMMARY-PRICE FILTER METHODOLOGY

• Estimate Mispriced amount
• a. Identify abnormally priced / mispriced transactions outside the 

benchmark bounds
• Overpriced if above the upper bound price
• Underpriced if below the lower bound price
• b. How to measure mispricing?
• Overvalued = (Declared value) – (value based on upper bound price)
• Undervalued = (value based on lower bound price) – (Declared 
value)



WHAT IS PIVOT TABLE AND WHY USE IT?

• A PivotTable is an interactive way to quickly summarize large amounts 
of data. 

• You can use a PivotTable to analyze numerical data in detail, and 
answer unanticipated questions about your data. 

• A PivotTable is especially designed for: Querying large amounts of 
data in many user-friendly ways.

• Also helps you to clean and format your data ready for analysis



PIVOT TABLES OR POWER PIVOT?

• Power Pivot enables users to manipulate data input, create 
relationships, and better understand where the company currently 
stands in relation to one metric or another. 

• Power Pivot also enables users to create visual data that can be 
outputted to Excel worksheets. It includes PivotTables and 
PivotCharts. 

• Power Pivot is an Excel feature that enables the import, manipulation, 
and analysis of big data without loss of speed/functionality.

• Power Pivot tables are pivot tables that that allow the user to mix 
data from different tables, affording them powerful filter chaining 
when working on multiple tables.



Creating a Pivot Table

• To Manually create a PivotTable
• Load your data
• Clean your data
• Click a cell in the source data or table range.
• Go to Insert > PivotTable. ...
• Excel will display the Create PivotTable dialog with your range or table 

name selected. ...
• In the Choose where you want the PivotTable report to be placed 

section, select New Worksheet, or Existing Worksheet.



Creating the Pivot Table

• Step 4: Create a Pivot Table
• Select the Data You Want to Analyze.
• Choose “Pivot Table” from the “Insert” Tab.
• Select the Data You Want to Add to Your Table.
• Open the New Worksheet Tab.
• Choose the Fields for Your Pivot Table.
• Drag the Fields to the Desired Area.
• Change the Value Field.
• View Your New Pivot Table.



EXAMPLE-PRACTICE EXERCISE

• Load the practice file called ???
• When file opens,go to



WHAT IS PIVOT TABLE AND WHY USE IT?

• A PivotTable is an interactive way to quickly summarize large amounts 
of data. 

• You can use a PivotTable to analyze numerical data in detail, and 
answer unanticipated questions about your data. 

• A PivotTable is especially designed for: Querying large amounts of 
data in many user-friendly ways.

• Also helps you to clean and format your data ready for analysis



Preparing data files for Pivot table analysis

• Load data file into excel
• Before analysis, file needs to be cleaned and formatted 
• Lets get on and practice



Creating a Pivot Table

• To Manually create a PivotTable
• Load your data
• Clean your data
• Click a cell in the source data or table range.
• Go to Insert > PivotTable. ...
• Excel will display the Create PivotTable dialog with your range or table 

name selected. ...
• In the Choose where you want the PivotTable report to be placed 

section, select New Worksheet, or Existing Worksheet.



• Step 4: Create a Pivot Table
• Select the Data You Want to Analyze.
• Choose “Pivot Table” from the “Insert” Tab.
• Select the Data You Want to Add to Your Table.
• Open the New Worksheet Tab.
• Choose the Fields for Your Pivot Table.
• Drag the Fields to the Desired Area.
• Change the Value Field.
• View Your New Pivot Table.



EXAMPLE-PRACTICE EXERCISE

• Load the practice file called ???
• When file opens,go to



WHAT IS THE INTERQUARTILE AND WHY USE IT

• five-number summary is mostly used IN STATISTICS as it gives a rough 
idea about the dataset.

• 1.Minimum value: It is the minimum value in the data set.
• 2.First Quartile, Q1: It is also known as the lower quartile where 25% 

of the scores fall below it.
• 3.Median (middle value) or second quartile: It is basically the mid-

value in the dataset.
• 4.Third Quartile, Q3: It is also known as the Upper quartile in which 

25% of the data is above it and the rest 75% falls below it.
• 5.Maximum value: It is the maximum value in the dataset.



PRICE FILTER METHOD

• Arm’s length price filter: benchmark upper and lower bounds of 
prices for each commodity

• a. Market price filter: (market price) +/- 5%, 10%, or more
• b. Non-market price filter (Pak and Zdanowicz (1994): Statistical 

estimates
• Upper and lower prices in quintiles (eg: quartile, quintile, or decile) 
for each commodity code
• c. Requires detailed trade data at transaction level
• No need for partners’ trade statistics



Interquartile Range

• Mathematically, it is basically defined as the difference between the 
third quartile (75th  percentile) and the first quartile (25th percentile).

• Q3-Q1
• IQR denotes the middle 50% hence also known as midspread or H-

spread in statistics



Interquartile range calculation

• Follow the below steps to calculate the same:
• Step 1: Insert the dataset.
• Step 2: Select any cell where you want to write the formula to 

calculate the values of Q1, Q3, and IQR.
• Step 3: First find the values of Q1 and Q3 using the quart values as 1 

and 3 respectively.
• Step 4: deduct Q1 from Q3
• Step 5: Lets practice



CREATING INTERQUARTILE RANGE

• PRICE=Value/Quantity
• Total 195 records
• Low Quartile at 195*0.25 = 49th (go to row 52)
• Median price at 195*0.5 = 98th   (go to row 102) 
• Upper quartile at 195*0.75 = 146th (go to row 149)

• Overpriced =(price - upper quartile price) or zero if negative
• Underpriced = (PRICE -lower quartile price) or zero if negative
• Lower Quartile Price=3.803468208
• Upper Quartile Price=6.020361991



SUMMARY-PRICE FILTER METHODOLOGY

• Estimate Mispriced amount
• a. Identify abnormally priced / mispriced transactions outside the 

benchmark bounds
• Overpriced if above the upper bound price
• Underpriced if below the lower bound price
• b. How to measure mispricing?
• Overvalued = (Declared value) – (value based on upper bound price)
• Undervalued = (value based on lower bound price) – (Declared 
value)



Guide to Modeling PCM for Ghana 
File: Lesson 9: PCM-PowerPivot-Ghana2012_Analysis_v1.xlsx 
 

I. Objectives:  
a. Estimate the difference between Ghana’s reported export to its partner countries 

(Ghana_X.xlsx) and Partner countries’ reported import from Ghana (Partner_M.xlsx) 
b. Estimate the difference between Ghana’s reported import from its partner countries 

(Ghana_M.xlsx) and Partner countries’ reported export to Ghana (Partner_X.xlsx) 
c. Identify top 10 or 20 high-risk countries with misinvoicing in export and import 

 
II. Data source: IMF DOTS, 2012 monthly. 

 
III. Complication:  

The list of partner countries reported by Ghana does not match the partner countries which 
reported having trade (export or import) with Ghana. 
Illustration:  
a. Ghana’s export list of partner countries: A, B, C, D 
b. List of Countries reported as having imported from Ghana: A, B, D, E. 
c. For Country C, Ghana reported as having exported but Country C did not report any 

import from Ghana 
d. For Country E, Ghana has no record of having exported to E, but E reported as having 

imported from Ghana 
e. To put together all the data from Ghana’s export and Partners’ import, we need to 

create a list of all countries: A, B, C, D, and E: Name the file as 
PCM_Ghana_X_Analysis.xlsx (PCM_Ghana_M_Analysis.xlsx for import analysis.) This 
file has only one column with a list of all the countries, A, B, C, D, E. 

f. Using Power Pivot in Excel, build a model relating PCM_Ghana_X_Analysis.xlsx to 
Ghana_X_2012.xlsx and Partner_M_2012.xlsx and create calculated fields: 

i. Export_Over_Invoiced_amount =  MAX(0, (Ghana_X – Partner_M/1.1)) 
ii. Export_Under_Invoiced_amount = MAX(0,(Partner_M/1.1 – Ghana_X)) 

iii. Dividing import data by a factor of 1.1 is because import data is reported as CIF 
while export data as FOB. 

 
IV. Modeling PCM using Power Pivot for Ghana Export misinvoicing 

a. Open a new Excel blank workbook. Save it as =xlsx  
(If Power Pivot is not activated, activate Power Pivot:  File > Options > Add-ins > Select 
“Microsoft Power Pivot for Excel” from Inactive Application Add-ins list) 

b. Click “Power Pivot” from the ribbon 



c. Click Manage 

 
d. To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External 

Data” group 

e. You will see a list of Relational Databases. Scroll through to the bottom of the list. Select 
Excel File (or Text File for importing a CSV file) > Browse > & check “Use first row as 
column headers” > Next > Finish (name the table as Ghana_X) 

f. Repeat to import Partner_M_2012.xlsx (name the table as Partner_M) and 
PCM_Ghana_X_Analysis.xlsx (name the table as Ghana_X_IFF) 

g. Click “Diagram View”  in View Group 

h. Then you will see three tables 



 
 

i. At this point, three tables are not related to each other. To model the relation between 
Ghana_X_IFF and Ghana_X, drag the field, “Partner” from Ghana_X_IFF to “Partner” in 
Ghana_X. Repeat this process for Partner in Ghana_X_IFF to Reporter in Partner_M . 

j. There should be lines linking tables. At the ends of the lines, a “*” should be on the side 
of Ghana_X_IFF table and a “1” on Ghana_X and Partner_M. This indicates one-to-many 
relations. 

 

k. Now click “Data View” in the View group: 

 
 



 
You should see a list of three tables at the 
bottom: Ghana_X, Partner_M, 
Ghana_X_IFF. Above Ghana_X_IFF, only one 
table heading (field name) is shown: 
Partner.  
Inserting Calculated Fields 
Double click the heading “Add Column” on 
the top right-hand side, and you can name a 
new field name to be calculated. Name it as 
Ghana_X. Add three more columns: 
Partner_X, Ghana_X_Over, 
Ghana_X_Under. Notice the calculated 
fields are highlighted in black. 
 
Now put a formula for each calculated field: 
Start with Ghana_X: 
- Click the heading 
- Type “=” and continue type 
“related(" > select the field 
“Ghana_X[G_X_2012] > type with a closing 
parenthesis “)”. Notice the column will be 
populated with the export data from 
Ghana_X table. 
- Repeat the same procedure for 
Partner_M field, 
“=Related(Partner_M[_P_M_2012])” 

 
 

- Now put a formula for Ghana_X_Over as:  
 “=max(0,Ghana_X_IFF[Ghana_X]-Ghana_X_IFF[Partner_M]/1.1)” 

- Repeat for Ghana_X_Under “=max(0,Ghana_X_IFF[Partner_M]/1.1-Ghana_X_IFF[Ghana_X])” 



 

For easy reading, the numbers may be formatted as $ with no decimals.  
This completes the Ghana’s Export overinvoicing and Export under-invoicing calculation. 
 

V. Create Pivot Table to sort by IFF amount and identify high-risk partners 
a. PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet” 

 

 
b. Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un 

 



 
 

c. Select the entire pivot table and copy it. 
d. Paste it in a range somewhere below the pivot table: Click Home > Paste (down arrow) > 

Select “Values (V)”  from “Paste Values” group 
e. To find the list of top 10 (or 20) high risk countries with Export Underinvoicing, sort the 

table in descending order of Ghana_X_un.  
 

f. To find the list of top 10 (or 20) high risk countries with Export Overinvoicing, sort the 
table in descending order of Ghana_X_ov.  

 
VI. Modeling PCM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import analysis, follow the same process as in “IV. Modeling PCM using Power 
Pivot for Ghana Export misinvoicing” and “V. Create Pivot Table to sort by IFF amount and 
identify high-risk partners.” 

 
 

 This file directory/FileName: 
 G:\Ghana2021\Worshop\Session09_PCM_PowerPivot\PCM-PowerPivot-Ghana2012_Analysis_v1.docx 
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	(If Power Pivot is not activated, activate Power Pivot:  File > Options > Add-ins > Select “Microsoft Power Pivot for Excel” from Inactive Application Add-ins list)
	b. Click “Power Pivot” from the ribbon
	c. Click Manage
	d. To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External Data” group
	e. You will see a list of Relational Databases. Scroll through to the bottom of the list. Select Excel File (or Text File for importing a CSV file) > Browse > & check “Use first row as column headers” > Next > Finish (name the table as Ghana_X)
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	k. Now click “Data View” in the View group:
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	Inserting Calculated Fields
	Double click the heading “Add Column” on the top right-hand side, and you can name a new field name to be calculated. Name it as Ghana_X. Add three more columns: Partner_X, Ghana_X_Over, Ghana_X_Under. Notice the calculated fields are highlighted in b...

	V. Create Pivot Table to sort by IFF amount and identify high-risk partners
	a. PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet”
	b. Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un
	c. Select the entire pivot table and copy it.
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